
EndNote

แนะน ำวิธีกำรใช้งำนเบือ้งต้น



EndNote คืออะไร ?

• Bibliography Software

• Personal Bibliographic Managers (PBM)

• โปรแกรมจดัการบรรณานุกรมและการอ้างอิง
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Endnote
Papyrus
ProCite
Reference Manager
RefWorks’ Direct Export Tool

โปรแกรมจดัการบรรณานุกรมและการอ้างองิ

นิยมใช้



1. แบบเดสทอ็ป (Desktop) ห้องสมุดน ามาใช้

2.แบบเวบ็แอพพลิเคชัน่ (Web Application) 

3. แบบโมบายแอพพลิเคชัน่ (Mobile Application) 

โปรแกรมเอน็ดโ์น้ตมี 3 รปูแบบ 




• จดัเกบ็บรรณานุกรมในรปูฐานขอ้มลูได้

ไมต่ ่ากวา่ 30,000 รายการต่อ 1 Library 
(แต่ละฐานขอ้มลูเรยีกวา่ Library มนีามสกุล
เป็น .enl)

• สบืคน้ แกไ้ข เปลีย่นแปลงขอ้มลูในรายการ  
บรรณานุกรมได้

ลกัษณะของ EndNote





• Import จากฐานขอ้มลูทรพัยากรสารสนเทศ
หอ้งสมุดและฐานขอ้มลูออนไลน์ต่าง ๆ ได ้

• เลอืกรปูแบบบรรณานุกรม(Styles) ไดม้ากกวา่ 
1,000 รปูแบบ เชน่  APA, Vancouver เป็นตน้
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ลกัษณะของ EndNote (1)





• เลอืกสรา้งบรรณานุกรม (Reference Types) 
ไดห้ลากหลายประเภท  เชน่ หนงัสอื บทความ ปรญิญานิพนธ์
เวบ็เพจ  เป็นตน้

• สามารถแนบไฟลอ์ื่นๆ ทีเ่กีย่วขอ้ง เชน่ รปูภาพเอกสารใน
โปรแกรมเวริด์ฯ ไฟล ์PDF ไวใ้นรายการบรรณานุกรม

ลกัษณะของ EndNote (2)



ตวัอย่าง Endnote Library





รปูแบบบรรณานุกรมท่ีใช้  (Style)

ช่องสืบค้นข้อมลูเพ่ือน าเข้าบรรณานุกรมกรณีต้องการจดักลุ่ม
รายการบรรณานุกรม

พืน้ท่ีส าหรบัแสดงบรรณานุกรมแก้ไข
และดไูฟลเ์อกสารแนบฐานข้อมลูท่ีต้องการสืบค้น





คลิก 1 ครัง้ท่ีรายการใด 
ด้านล่างจะแสดงบรรณานุกรมของรายการนัน้ดบัเบ้ิลคลิกท่ีรายการใด

จะแสดงข้อมลูทางบรรณานุกรมของรายการนัน้แก้ไขปรบัปรงุข้อมลูต่างๆได้





เมื่อดบัเบ้ิลคลิกรายการจากหน้าท่ีแล้วหน้าจอจะแสดงข้อมูลทาง
บรรณานุกรมต่างๆ  ของรายการนัน้ๆปรบัเปล่ียนแก้ไขได้ตามต้องการ   

ประเภทของวสัดุ



เช่ือมโยงไป file ต่างๆ ท่ีต้องการแนบ
ไว้ เช่น PDF รปูภาพ เอกสารอ่ืนๆ

สามารถกดดไูฟลท่ี์แนบโดยการคลิกท่ีไฟลด้์านบนจะปรากฏ
หน้าต่างเอกสารแนบขึน้มา

กรณีเป็นฐานข้อมูลออนไลน์
ท่ีมีบทคดัย่อ



1. สร้างฐานข้อมลู (Library)

ขัน้ตอนการใช้ Endnote

2. น ำขอ้มูลบรรณำนุกรม เขำ้
ฐำนขอ้มูล

3. น ำเสนอขอ้มูลบรรณำนุกรมใน
โปรแกรม Word

Download จาก
Library Catalog

Download จาก  
Online Databases

พิมพข้์อมลูเข้า



ขัน้ท่ี 1
การสร้างฐานข้อมลู (Library)





หรือ เมนู File เลือก New…
1.เลือก New เมื่อต้องการสร้าง Library ใหม่ เลือก 

Open เม่ือต้องการเปิด Library ท่ีมีอยู่แล้ว

2. เลือกท่ีจดัเกบ็ 

3. ตัง้ช่ือ Library.enl

4. บนัทึก





หลงัจากตัง้ช่ือ Library 
จะปรากฏหน้าจอของ Library 

ท่ีรอการสร้างข้อมูลบรรณานุกรม



การน าเสนอเฉพาะการจดั
กระท าข้อมลูท่ีอยู่ใน library

น าเสนอเฉพาะการจดักระท า
ของข้อมลูในส่วนของการ
สืบค้นออนไลน์

1. Group Panel

น าเสนอรวมทัง้จดัการข้อมูลท่ี
อยู่ใน library และการสืบค้น
ออนไลน์เลือกมุมมองการแสดงของส่วน Group Panel



2. Reference Panel : 

- Reference แสดงข้อมลู
ประเภททรพัยากร
(Reference Type) และ
ข้อมลูในแต่ละ Field ของ
แต่ละรายการ

- Preview แสดงรปูแบบการ
เขียนบรรณานุกรมตามท่ี
ก าหนดของแต่ละรายการ

- Attach PDF แสดงข้อมลู
เอกสารฉบบัเตม็ในรปู 
PDF ของแต่ละรายการ



สามารถปรบัย้ายมมุมองได้ของพืน้ท่ีแต่ละส่วนได้ โดยคลิกเลือกท่ีปุ่ ม
Layout มมุขวาล่าง 



ขัน้ท่ี 1.2
การตัง้ค่าเบือ้งต้น

1. การตัง้ค่าให้พิมพภ์าษาไทยได้

2. การ Download Style ของ มศว เข้าไปยงัโปรแกรม Endnote



1. การตัง้ค่าให้พิมพภ์าษาไทยได้ (ต้องเลือก Font ท่ีสามารถพิมพภ์าษาไทยได้)

Edit>Preferences>Display Fonts>Library,General,Labels,Search>Change Font>OK

1

2

3

4

5

6

ตัง้ค่า Font ***เลือก Cordia new ขนาด 16  เปล่ียนให้เหมือนกนัหมด ทัง้ Library General Labels Search



2. การ Download Style ของ มศว เข้าไปยงัโปรแกรม Endnote

1. สามารถDownload Style ของ มศว ได้ท่ี 
http://lib.swu.ac.th/download_endnote/login.php

2. เลือก Style ท่ีต้องการน าไปใช้  
(โปรแกรม Endnote ใช้ได้เพียง 1 Style เท่านัน้ )
- APA 6Th SWU-EN
- APA 6Th SWU-TH*ส าหรบัภาษาไทย
- Vancouver SWU Eng
- Vancouver SWU Thai

3. เปิดโปรแกรม Endnote ให้เรียบร้อย 
คลิกเลือก Style ท่ีต้องการน าไปใช้

http://lib.swu.ac.th/download_endnote/login.php


2. การ Download Style ของ มศว เข้าไปยงัโปรแกรม Endnote (2)

1. คลิกเลือก Style ท่ีต้องการน าไปใช้

2. คลิก Style ท่ีโหลดมา

3. จะปรากฏหน้าต่างขึน้ในโปรแกรม Endnote ให้ไป
ท่ีเมนู File >Save As...  

4. กด Save แล้วปิดเคร่ืองหมาย X มมุบนขวามือด้าน
ในสดุ หรือ  Close Style



ขัน้ท่ี 2
การน าข้อมลูบรรณานุกรม
เข้าฐานข้อมลู (Library)





การน าข้อมลูเข้าท าได้ 3 วิธี

1.สรา้งข้อมลูบรรณานุกรมขึน้เองด้วยการพิมพ์

2. ถ่ายโอนข้อมลูบรรณานุกรมจากฐานข้อมูลทรพัยากรสารสนเทศห้องสมุด

3. ถ่ายโอนข้อมลูบรรณานุกรมจากฐานข้อมูลออนไลน์




วิธีท่ี 1 : สร้างข้อมูลบรรณานุกรมขึน้เองด้วยการพิมพ์

(โดยวิธีน้ีไม่ต้องใช้อินเทอรเ์น็ต)

สามารถDownload คู่มือการลงรายการอ้างอิง 
(Reference) ในโปรแกรม EndNote ตาม Style APA 
6th SWU
http://lib.swu.ac.th/download_endnote/login.php

http://lib.swu.ac.th/download_endnote/login.php


ไปท่ี เมนู References
เลือก New Reference



เลือกประเภทวสัดท่ีุต้องการกรอกรายละเอียด

หน้าแสดงส าหรบัการกรอกข้อมูล



2. คลิก Saveท่ีเมนู File

1. กรอกรายละเอียดในแต่ละเขตข้อมลู

3. คลิกปิดเพ่ือดผูล



ข้อมลูท่ีพิมพจ์ะเข้ามาสู้ EndNote สามารถด ูPreview ได้ 



การพิมพข้์อมลูรายการบรรณานุกรม
ในโปรแกรมEndnote



2. ช่ือคนภาษาองักฤษใส่ตามท่ีปรากฏจากหน้าปก
หนังสือ (หาก export ข้อมลูจากระบบสืบค้น 
ไม่ต้องแก้ไข)  เช่น  Anthony J. Hickey 
* หากมีผูแ้ต่งมากกว่า 1 คน ให้พิมพบ์รรทดัละช่ือ 

1. ผูแ้ต่งภาษาไทย ต้องใส่ , หลงันามสกลุ เช่น
ปภาดา น้อยค ายาง, 

* หากมีผูแ้ต่งมากกว่า 1 คน ให้พิมพบ์รรทดัละช่ือ 



3. กรณีผูแ้ต่งเป็นหน่วยงานท่ีมีทัง้หน่วยงานเลก็และหน่วยงานใหญ่ ให้
พิมพห์น่วยงานใหญ่ ตามด้วยหน่วยงานเลก็ คัน่ด้วยเคร่ืองหมาย“,” 
เช่น  คณะวิทยาศาสตร ์มหาวิทยาลยัขอนแก่น,



Reference Type ประเภททรพัยากร > Book

Author (ผูแ้ต่ง) กลัยา วานิชยบ์ญัชา,   
*เฉพาะผูแ้ต่งคนไทย ใส ่, (จุลภาค) หลงันามสกุล

Year (ปีทีพ่มิพ)์ 2558

Title (ชือ่เรือ่ง) สถติสิ าหรบังานวจิยั

Edition (ครัง้ทีพ่มิพ)์ พมิพค์รัง้ที่ 9   *หากเป็นการพมิพค์รัง้ที ่1 ไมต่อ้งระบุ

Place Published (เมอืงทีพ่มิพ)์ กรงุเทพฯ

Publisher (ส านกัพมิพห์รอืผูจ้ดัพมิพ)์ ศนูยห์นงัสอืจุฬาลงกรณ์มหาวทิยาลยั

ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท : หนังสือ (BOOK)
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Reference Type ประเภททรพัยากร >> Journal Article (บทความวารสาร) 

Author (ผูแ้ต่ง) ปรดี ีปลืม้ส าราญ,

Year (ปีทีพ่มิพ)์ 2554

Research Notes (วนั เดอืน) *ภาษาไทย
(เดอืน วนั) *ภาษาองักฤษ 

กรกฎาคม-ธนัวาคม *ถา้มี

Title (ชือ่บทความ) ความสามารถในการเขา้ถงึไดท้างเวบ็

Journal (ชือ่วารสาร) วารสารบรรณศาสตร ์มศว

Volume (ปีที)่ 4

Issue (ฉบบัที)่ 2

Pages (เลขหน้า) 105-109

ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท Journal Article (บทความวารสาร)





ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท Electronic Article (บทความวารสารอิเลก็ทรอนิกส)์

Reference Type ประเภททรพัยากร > Electronic Article (บทความวารสารอิเลก็ทรอนิกส)์ 

Author (ผูแ้ต่ง) พเิชษฐ์ พลพชิติ,

Year (ปีทีพ่มิพ)์ 2560

Research Notes (วนั เดอืน) *ภาษาไทย
(เดอืน วนั) *ภาษาองักฤษ 

กรกฎาคม-ธนัวาคม *ถา้มี

Title (ชือ่บทความ) วฒันธรรมสารสนเทศสขุภาพในชุมชนชนบทไทย

Journal (ชือ่วารสาร) วารสารบรรณศาสตร ์มศว

Volume (ปีที)่ 10

Issue (ฉบบัที)่ 2

Pages (เลขหน้า) 63-77

URL สบืคน้จาก   http://ejournals.swu.ac.th/index.php/jlis/article/view/9957/8448
(*ภาษาองักฤษ เปลีย่นค าวา่ “สบืคน้จาก” เป็น “Retrieved from”)

http://ejournals.swu.ac.th/index.php/jlis/article/view/9957/8448
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Reference Type ประเภททรพัยากร >>  ปริญญานิพนธ ์

Reference Type (ประเภททรพัยากร) Thesis

Author (ผูแ้ต่ง) วริยิะ โภคาพนัธ,์

Year (ปีทีพ่มิพ)์ 2558

Title (ชือ่เรือ่ง) การศกึษาและพฒันาแบบทดสอบภาวะผูน้ าเชงิสรา้งสรรคข์องครู

Place Published (สถานทีต่ ัง้) กรงุเทพฯ

University (มหาวทิยาลยั) มหาวทิยาลยัศรนีครนิทรวโิรฒ

Degree (ระดบัปรญิญานิพนธ)์ ปรญิญานิพนธป์รญิญาดุษฎบีณัฑติ (Doctoral dissertation) 
หรอื ปรญิญานิพนธป์รญิญามหาบณัฑติ (Master's thesis)

ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท : ปริญญานิพนธ ์(ตวัเล่ม)
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Reference Type ประเภททรพัยากร >>  Thesis ปริญญานิพนธ ์

Author (ผูแ้ต่ง) วรรณชนก รอดหยู,่

Year (ปีทีพ่มิพ)์ 2561

Title (ชือ่เรือ่ง) รปูแบบการพฒันาสูโ่รงเรยีนสอนคดิ

Academic Department  
(มหาวทิยาลยั, สถานทีต่ ัง้)

มหาวทิยาลยัศรนีครนิทรวโิรฒ, กรงุเทพฯ

Thesis Type (ระดบัปรญิญานิพนธ)์ ปรญิญานิพนธป์รญิญาดุษฎบีณัฑติ (Doctoral dissertation)
หรอื ปรญิญานิพนธป์รญิญามหาบณัฑติ (Master’s thesis)

Degree (ระดบัปรญิญานิพนธ)์ ปรญิญานิพนธป์รญิญาดุษฎบีณัฑติ (Doctoral dissertation) 
หรอื ปรญิญานิพนธป์รญิญามหาบณัฑติ (Master's thesis)

URL สบืคน้จาก http://ils.swu.ac.th:8991/exlibris/aleph/a22_1/
apache_media/JAQPBVVBJXSY8VNIV4NY6RD6EQJUFB.pdf
*ภาษาองักฤษ เปลีย่นค าวา่ “สบืคน้จาก” เป็น “Retrieved from”

ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท : ปริญญานิพนธ ์(ออนไลน์)
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Reference Type ประเภททรพัยากร >> Web Page

Reference Type (ประเภททรพัยากร) Web Page

Author (ผูแ้ต่ง) ทบวงมหาวทิยาลยั

Year (ปีทีพ่มิพ)์ 2544

Title (ชือ่เรือ่ง) ประกาศทบวงมหาวทิยาลยั เรือ่ง มาตรฐานหอ้งสมุด
สถาบนัอุดมศกึษา พ.ศ. 2544

URL สบืคน้จาก http://www.mua.go.th/users/he-
commission/doc/law/ministrylaw/1-31 library standard 
2544.pdf

ตวัอย่าง    การลงรายการอ้างอิงในโปรแกรม Endnote
ส าหรบัวสัดแุต่ละประเภท :> Web page (ข้อมลูจากเวบ็ไซต)์

*ภาษาองักฤษ เปล่ียนค าว่า “สืบค้นจาก” เป็น “Retrieved from”



น าเข้าจากหน้าการสืบค้นทรพัยากรของห้องสมดุโดยตรง (SWUDisovery)

วิธีท่ี 2 : การน าเข้าจากฐานข้อมูลทรพัยากร
สารสนเทศของห้องสมุด



1. เข้าไปท่ีหน้าเวบ็ไซตข์องส านัก
หอสมดุกลาง URL : lib.swu.ac.th

2. ใส่ค าสืบค้นท่ีต้องการในกล่อง SWUDiscovery



ในกรณีท่ีเลือกรายการทรพัยากรของห้องสมุดรายการเดียว

เลือกรายการท่ีต้องการแล้วคลิกท่ี Export RIS



คลิกเลือก Download

รายการบรรณานุกรมท่ีเลือกจะปรากฏด้านล่าง คลิกเพ่ือส่งไปยงั Endnote



รายการบรรณานุกรมจะปรากฏในโปรแกรม Endnote



1. ใส่ค าค้นท่ีช่องสืบค้น

2. ปักหมดุ (Keep this item) เลือกรายการท่ี
ต้องการจดัเกบ็ไปยงั Endnote

ในกรณีเลือกบรรณานุกรมหลายรายการ

3. เม่ือเลือกรายการท่ีต้องการครบแล้วให้เลือกเครื่องหมายปักหมดุขวามือ 



4. เลือกรายการบรรณานุกรมท่ีต้องการส่งไปยงั Endnote ทัง้หมด 

5. เลือก ... แล้วคลิก Export RIS

6. คลิกเพ่ือส่งข้อมลูไปยงั Endnote



วิธีท่ี 3

วิธีท่ี 3 : ถ่ายโอนข้อมลูบรรณานุกรมจาก 
ฐานข้อมูลออนไลน์

Downloading from Online Databases
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มองหาค าว่า 

“Export” or “Save”



ตวัอย่างการสืบค้นผา่นฐานข้อมลู ProQuest 

1. เลือกรายการบรรณานุกรรมท่ีต้องการ Export

2. คลิกท่ีปุ่ ม Save และเลือก RIS เพื่อ Export ไปยงัโปรแกรม EndNote  



3. คลิก Continue 

4. คลิกเพ่ือส่งข้อมลูไปยงัEndNote



ข้อมลูท่ีเลือกไว้
จะได้รบัการถ่ายโอนเข้าสู่ EndNote



กรณีท่ีฐานข้อมลูออนไลน์บางฐาน ไม่ส่งข้อมลูไปยงั
Endnote โดยตรง แต่ให้บนัทึกข้อมลูลงเคร่ืองก่อน หลงัจากบนัทึกข้อมลูแล้ว ให้ด าเนินการดงัน้ี

ไปท่ีเมนู File เลือก Import และ File…

2.ก าหนดข้อมูลเพ่ือในการ Import ดงัน้ี

3. คลิกท่ี Import



ข้อมูลท่ีเลือกไว้จึงจะได้รบัการถ่ายโอนเข้าสู่ Endnote



กรณีต้องการแนบไฟล ์PDF เอกสารฉบบัเตม็หรือไฟลอ่ื์นๆ ไว้ด้วย

1.คลิกขวาเลือก File Attachments >>Attach File… 2. เลือกไฟลท่ี์ต้องการแล้วกด OPEN



ปรากฏการเช่ือมโยงสู่ไฟลท่ี์ต้องการแนบ

สามารถกดดไูฟลท่ี์แนบโดยการคลิกท่ีไฟลด้์านบนจะปรากฏ
หน้าต่างเอกสารแนบขึน้มา



กรณีต้องการแนบไฟลร์ปูภาพ ไว้ด้วย

1.คลิกขวาเลือก Figure>>Attach Figure…>เลือก
รปูภาพท่ีต้องการ กด OK



ขัน้ท่ี 3
การน าเสนอข้อมลูบรรณานุกรมในโปรแกรม

Microsoft Word



วิธีการอ้างอิงในเน้ือหา

ท าได้ 2 วิธี 
1. บรรณานุกรมท้ายบท/เล่ม
2. การอ้างอิงแทรกในเน้ือหา



กำรท ำบรรณำนุกรมทำ้ยบท/เล่ม



ขัน้ตอนการน าข้อมลูไปใส่ในโปรแกรม Word

1. เลือกรปูแบบ Style ท่ีต้องการ

2. เลือกรายการบรรณานุกรมท่ีต้องการ
หากเลือกทัง้หมด Ctrl+A  

3. จากนัน้คลิกขวา เลือก Copy 
Formatted 



5. คลิกขวาท่ีโปรแกรม Word 
เลือก Paste Options > Keep Source 
Formatting

4. เปิดโปรแกรม Word ขึน้มาแล้วน า
บรรณานุกรมไปวางไว้ตามท่ีต้องการ



กำรอำ้งอิงแทรกในเน้ือหำ



1. เปิดโปรแกรม Word แล้วน าเคอรเ์ซอรเ์มาสไ์ปวาง
ไว้หลงัต าแหน่งท่ีต้องการแทรกอ้างอิงในเน้ือเรื่อง

2. คลิกท่ี Go to Endnote

ขัน้ตอนการอ้างองิแทรกในเนือ้หา (1)





3.เลือก Style

4. เลือกเร่ืองท่ีต้องการอ้างอิงในเน้ือหาให้เป็นแถบสีฟ้า

5. คลิกท่ี Insert Citation

ขัน้ตอนการอ้างองิแทรกในเนือ้หา (2)



ข้อมลูบรรณำนุกรมในโปรแกรม Endnote
จะปรำกฏแทรกในเน้ือหำและท ำรำยกำรบรรณำนุกรมท้ำยเล่มให้ด้วย 

6. รายการอ้างอิงแทรกในเน้ือเร่ือง

7. รายการบรรณานุกรมท้ายรายการ

ขัน้ตอนการอ้างองิแทรกในเนือ้หา (3)



การตัง้ค่าการแทรกอ้างอิงในเน้ือหาด้านหน้าข้อความ

1. ดึงรายการอ้างอิงมาจากโปรแกรม Endnote
เรียบร้อยแล้วใส่หน้าข้อความท่ีต้องการอ้างอิง

2. คลิกขวา Edit Citation(s) > Display As : Author(Year)



การแทรกเลขหน้าในการอ้างอิงในเน้ือเร่ือง

1. วาง Cursor ตรงรายการอ้างอิงท่ีต้องการเพ่ิมเลขหน้า
ให้เป็นแถบสีเทา คลิกขวาเลือก Edit Citation(s) และ More… 



2. ใส่เลขหน้าท่ี Pages กด OK

เลขหน้าปรากฎท่ีอ้างอิงในเน้ือเร่ือง

การใส่เลขหน้าภาษาไทย 
- น. 5-6

ภาษาองักฤษ
- หน้าเดยีว p.1 
- 2 หน้าขึน้ไป pp. 2-3

การแทรกเลขหน้าในการอ้างอิงในเน้ือเร่ือง (2)



การอ้างถึงใน /as cited in ในโปรแกรม EndNote

ดึงบรรณานุกรมมาจากโปรแกรม Endnote แล้วคลิกขวา   
Edit Citation(s) More… และใส่รายการอ้างอิงเข้าไปใน Prefic... 



การตัง้ค่าเม่ือรายการอ้างอิงติดเรือ่งหมายปีกกา {}

ไปท่ีแถบเมนูด้านบนตรง EndnoteX9 เลือกตรง 
Instant Formatting is Off ให้เลือกเป็น Turn Instant Formatting On





การจดัการการแสดงผลของข้อมลู





Edit Preferences

จดัรปูแบบการแสดงผล เชน่
รปูแบบอกัษร 
ขอ้มลูทีต่อ้งการใหป้รากฏ
ฯลฯ





เลือกเมนู Edit>Preferences 

สามารถเลือกรายการท่ีต้องการ
ปรบัเปล่ียนแก้ไขได้





Change Case : ก าหนดลกัษณะอกัษร
ของค าภาษาองักฤษให้เป็นตวัพิมพใ์หญ่

หรือตวัพิมพเ์ลก็ทัง้หมด
Display Fields : ก าหนดข้อมลูท่ีต้องการให้แสดง



การตัง้ค่าให้บรรณานุกรมท่ีมีเอกสารฉบบัเตม็สามารถ Imported เอกสารฉบบัเตม็เข้ามาในโปรแกรมอตัโนมติั

1

2

3

4

Edit>Preferences>Find Full Text>Automatically…>OK

5



*Do nothing : ไมต่อ้งแสดง Libraries ใดๆ
- Open the Mostly : ใหเ้ปิด Libraries ล่าสุดขึน้มา
- Open the specified : กรณมีหีลาย Libraries แต่ตอ้งการเลอืกใหแ้สดงเฉพาะ 
Libraries ทีต่อ้งการ (กรอกชือ่ Libraries เขา้ไป)
- Prompt to select a library : จะแสดงไดรฟ์มาใหเ้ลอืกวา่จะเปิด Libraries ใด

Libraries : ตัง้ค่าแสดงหน้า Libraries เม่ือเปิดโปรแกรมขึน้มา

1

1

2

3

4





การตรวจสอบข้อมลูซ า้ซ้อน

1. คลิกท่ีเมนู References > Find Duplicates





หากมีช่ือเร่ืองซ า้กนัจะประกฎรายการบรรณานุกรมให้เลือก

หากไม่มีข้อมลูบรรณานุกรมซ า้กนั 
จะปรากฎ(No duplicate references found)



การจดัการข้อมลู : Custom Group





วิธีการสร้าง Groups

Groups— create groups set (การสร้าง Group ใหญ่)

การท า Group ย่อย--create groups—ตัง้ช่ือ—สามารถแก้ไขช่ือ
ได้โดยการดบัเบิลคลิกหรือคลิกขวา Edit





1. เลือกรายการบรรณานุกรมท่ีต้องการจดักลุ่ม 

2. คลิกขวา>เลือก Add References To : เลือก My Groups 
ท่ีต้องการจดักลุ่ม





Smart Group > การสร้าง Group อจัฉริยะ

ตัง้ช่ือ แล้วเลือก reference type แล้วเลือกท่ีต้องการ 
เช่น Journal , book, 

เป็นการแยกหมวดหมู่ของรายการ ต่อไปหากสืบค้น
เข้ามาอีก รายการจะว่ิงเข้ามาแยกตาม 

ประเภทท่ีเราแยกเอาไว้ และสามารถแยกตามปี ท่ี
เข้ามา ได้ด้วย เลือก year แล้วพิมพปี์ท่ีต้องการแยก







การส ารองข้อมลูข้อมลู EndNote
(กรณีต้องการจดัเกบ็/จดัส่งข้อมลู)



1. ไปท่ีเมนู File เลือก Compressed Library (.enlx) 

2. คลิกปุ่ ม Next



3. เลือกไดรฟ์ท่ีต้องการจดัเกบ็ในคอมพิวเตอร>์กด Save



• จดัท ำโดย ศิวพร ชำติประสพ /พฤษภำคม 2563

ติดต่อสอบถำม...
งำนส่งเสริมผูใ้ช้ ฝ่ำยบริกำรทรพัยำกรสำรสนเทศ
ส ำนักหอสมดุกลำง มหำวิทยำลยัศรีนครินทรวิโร 

โทร. 026495443 ต่อ 15386
https://www.facebook.com/libswu


